
아이폰 iPhone은현재가장특색있는게임플랫폼중하나이다. 터치화면, 아이튠즈
iTunes와의 통합, Objective-C를 사용하는 프로그래밍, 적은 개발비용,쉬운 제품

출시등은매우낯설지만새로운개발기회를약속한다. 모바일폰시장에가장늦

게진입한아이폰은주목할만한점유율을보이고있고, 모토로라, 삼성, LG 같은

제조사의모방기기열풍을이끌어내고있다.

프로그래머로서 판매량이나 시장 점유율에 감흥이 없을수도 있지만, 전체적으로

아이폰의 생존 능력에는 흥미를 가져야 할 것이다. 사람들이 아이폰을 가지고 있

지않다면프로그래머가만든게임을아무도사지않을것이다. 좋은소식은 2009

년경제침체국면에도불구하고, 아이폰은계속해서팔렸다는것이다.

아이폰을 시작하기 위해서는 무료 애플 개발자 계정을 받아야 한다. 그 다음에는

맥Mac에 아이폰 SDK를 다운받는다. SDK에는 Xcode IDE와 화면을 구성하는 인

터페이스 빌더Interface Builder 도구가 포함돼 있다. 애플은 윈도우즈를 비롯한 맥이 아

닌 플랫폼에는 개발도구를 제공하지 않으므로 반드시 맥이 있어야 한다. 그리고

아이폰 API는 Objective-C를사용해야하므로이에대해잘모른다면관련입문

서를읽어야한다. 이장에서는이작업모두를단계별로설명할것이다.
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애플 개발자 계정과 SDK 다운로드

아이폰개발환경구축의첫단계는애플개발자계정을등록하는것이다. 계정가

입은무료이며이를통해애플의온라인문서, 튜토리얼비디오, SDK 다운로드에

접근할수있다.

1.. http://developer.apple.com/iphone/에접속한다.

2..등록Register 링크를클릭하고 Start Now를클릭한다. new Apple ID 만들기

옵션을 선택하거나 아이튠즈나 앱스토어App Store 계정에서 쓰던 Apple ID로

로그인한다.

3..등록을하면아이폰개발센터에로그인할수있다.

4..애플에서무료 SDK를다운로드하는링크를이메일로이미보냈거나, 웹사

이트의링크를통해 SDK 다운로드를선택할수있을것이다. SDK 다운로

드패키지안에는이미 Xcode가포함되어있으므로따로 Xcode를받을필

요가없다는점을알아두자. 그리고 SDK에는최신버전의 Xcode가포함되

어있다.

5..다운로드하고 SDK를 설치하면, 하드 드라이브의 /Developer/Applications

폴더에서 Xcode와인터페이스빌더를찾을수있다. 이두애플리케이션을

빠르게 실행하기 위해 검색기능Spotlight을 이용하여 Xcode와 인터페이스 빌

더를찾을수도있다.

무료 개발자 계정으로 애플리케이션을 만들고 맥의 시뮬레이터를 통해 애플리케

이션을실행할수있다. 그러나애플리케이션을아이폰에서테스트하려면유료개

발자 프로그램에 가입해야 한다. 1년 단위로 내는 비용이 크지 않기 때문에 지갑

이얇은개인개발자일지라도그리부담되지는않을것이다.

1.. http://developer.apple.com/iphone/program/apply.html에접속한다.

2..스탠다드 프로그램과 엔터프라이즈 프로그램이란 두 옵션이 있다. 일반적

인목적으로프로그램을만든다면아마엔터프라이즈프로그램은필요하지

않을 것이다. 설명을 모두 읽었다면 엔터프라이즈 프로그램이 회사에서 내

부적으로 사용할 프로그램을 만들기 위한 것임을 알 수 있을 것이다. 만일

제작한 게임을 앱스토어를 통해 판매할 계획이라면, 스탠다드 프로그램이
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옳은선택이될것이다.

3..Enroll Now를선택하고필요할경우로그인한다.

4..이제 다른 선택이 가능하다. 개인이나 혹은 회사로 등록하는 것이다. 개인

을 선택하면, 개발과 테스트 단계에서 다른 이들에게 애플리케이션을 배포

하는 데에 필요한 다른 프로그래머나 품질 보증 멤버를 계정에 추가할 수

없을 것이다. 만약 회사를 선택한다면, 회사에 대한 자세한 정보 제공을 요

청받을것이다.

5..적당한정보를선택하면서‘Thank you for submitting your enrollment

(등록해주셔서 감사합니다)’라는 문구가 적힌 화면을 만날 때까지 웹사이트를

통해 계속 진행한다. 이제 애플의 이메일을 기다린다(도착할 때까지 대략 한

달정도걸릴것이다).

유료 개발자 프로그램 가입은 애플이 활성화하는 동안 아이폰 OS와 SDK의 최신 버전 베타 릴
리즈에 접근할 수 있게 해준다. 

실제 필요할 때 쓸 수 있도록 가능한 빨리 유료 개발자 계정 등록을 해두는 것이

좋다.

1.1.1 애플리케이션 번들

Xcode를 사용하여 애플리케이션을 만들 때 마지막 결과를 애플리케이션 번들
Application Bundle이라부른다. 맥 OS X와아이폰에서애플리케이션번들은실행파일과

실행하는데에필요한리소스를지닌특수한타입의디렉터리다. 이것은애플리케

이션을나타내는아이콘과애플리케이션에대한특수한정보를지닌파일, 애플리

케이션이사용하는이미지나사운드를포함한다.

파인더Finder에서 애플리케이션 번들은 단순히 애플리케이션 아이콘으로 나타난다. 우클릭이나
컨트롤-클릭을 하고 메뉴의 View Package Contents를 선택하면 안에 무엇이 들어있는지
볼 수 있다.

아이폰에서는 이렇게 할 수 없지만 아이폰 시뮬레이터는 아이폰 애플리케이션을 찾을 수 있다.
아이폰 SDK를 설치했다면 검색 기능을 사용하여 MobileSafari.app 파일을 찾을 수 있다. 이
파일을 파인더에서 열고(맥에서 실행하지는 말고) 패키지 콘텐츠를 보라.
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전형적인아이폰애플리케이션번들은다음구조를지닌다.

Executable

(필수) 컴파일하여 실행가능한 코드이다. 보통 애플리케이션과 같은 이름을 지

닌다. 

MobileSafari.app에서이파일의이름은 MobileSafari이다.

Info.plist

(필수) 키-값의 쌍으로 이루어진 형태인 속성들의 컬렉션이다. 애플리케이션

에대한중요한정보를기록한다. 이중에서주목할만한속성은애플리케이션

의이름, 버전숫자, 유니크 ID 숫자등이다. 이파일들은바이너리포맷을사

용하여 텍스트 에디터에서 읽을 수 없지만, /Developer/Applications/Utilities

에있는 Property List Editor를사용하면볼수있다.

icon.png

(필수) 아이폰의 홈 화면에서 애플리케이션을 표현하는 57×57픽셀의 아이콘

이다.광택 버튼 효과는 이미지의 윗부분에 자동으로 추가되므로 균일한 색으

로한다.

Various resources

(선택) 실행파일처럼이미지, 사운드, 바이너리데이터같은애플리케이션에서

사용하는모든일반적인리소스파일들은같은폴더에놓인다. 아이폰애플리

케이션번들에존재하는유일한하위폴더는각언어리소스의몫이다.

Localization folders

(선택) 애플리케이션이여러언어를지원한다면번들에각언어를담은리소스

를포함하는서브폴더를추가한다. 폴더이름은언어이름이나 ISO 언어약자

뒤에‘.lproj’를 붙인다. 예를 들면 English.lproj, French.lproj, German.lproj,

uk.lproj는각각영어, 프랑스어, 독일어, UK영국식 영어를포함한다.

Settings.bundle

(선택) 제작한 애플리케이션의 사용자 환경 옵션을 아이폰의 설정 애플리케이

션에서제공하려면이파일을만들어야한다.
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Icon-Settings.png

(선택) Settings.bundle 파일을추가했다면이이미지는설정애플리케이션에서

해당 애플리케이션을 표현하는 데에 쓰인다. 이미지는 29×29픽셀이어야 하

지만이미지를추가하지않으면 Icon.png 이미지를자동으로바꿔사용한다.

MainWindow.nib

(선택) 인터페이스빌더애플리케이션이만드는 MainWindow.nib는애플리케

이션이 시작할 때처럼 애플리케이션을 그리는 데에 필요한 코드와 리소스를

포함한다. 더 많은 .nib 파일을 이후에 읽어올 수 있지만, 이 파일이 메모리에

서항상첫위치에있다.

Default.png

(선택) 이 이미지는 애플리케이션이 MainWindow.nib 파일을 로딩하는 동안

보여준다. 아이폰에서는 480×320픽셀인 전체 화면 크기여야 한다. 애플리케

이션로딩을마치는동안유저에게이이미지를보여주면더적은시간이걸린

것처럼보일것이다.

iTunesArtwork

(선택) 애플리케이션을 앱스토어 밖에서 배포하면, 아이튠즈를 이용하여 핸드

폰에 로드하는 동안 애플리케이션을 나타내는 데에 이 아트웍artwork을 사용한

다. 자세한것은이후에다루도록하겠다.

다음 절에서 보겠지만, 애플리케이션을 만들 때에 Xcode와 인터페이스 빌더로

이파일들대부분을만들것이다.

1.1.2 Xcode와 인터페이스 빌더

Xcode에익숙하지않다면처음에는새 IDE를배우는것이다소부담스러울수는

있겠지만 이것은 아이폰 개발 작업에 반드시 필요한 일이다. IDE를 다루는 데에

익숙해지면 Xcode의편리함을알수있을것이다. 산업표준 IDE에필요한모든

기능을 가지고 있기 때문에 컴파일 에러가 난 곳으로 바로 이동할 수 있고, API

메소드를자동으로완성하거나 SDK 레퍼런스를통합할수있다.
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이 외에도 Xcode는 기기에서의 디버깅, 모든 기능을 갖춘 아이폰 시뮬레이터, 유

용한프로젝트마법사, 리팩토링도구,버전관리기능의직접적인통합을제공한다.

Xcode 프로젝트는 아이폰 애플리케이션을 만드는 데에 필요한 코드, 리소스, 인

증서, 환경설정모두를포함하고있다. 이환경을알기위해 Xcode IDE를열어서

다음단계를따라전형적인‘Hello World’애플리케이션을만들어보자.

1..Xcode를연다.

2.. File → New Project를선택한다.

3..열린 다이얼로그에서 iPhone OS를 선택하고, View-Based Application

을선택한다음 Choose를클릭한다. 그림 1-1을참조한다.

그림 1-1 View-Based Application을 선택

4..project를‘Hello World’라이름짓고 Save를클릭한다.

5..이 단계에 이르면, 빌드하고 실행할 수 있다(툴바의 Build와 Go 아이콘을 클릭
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한다). 시뮬레이터에서 실행하면 그림 1-2처럼 HelloWorld 애플리케이션

은텅빈회색화면만을보여준다.

그림 1-2 시뮬레이터의 텅 빈 애플리케이션

아직별로재미있지는않을것이다. 이‘Hello World’애플리케이션을만들기전

에프로젝트를만들때만들어진파일들에대해알아보자.

HelloWorldAppDelegate.m, HelloWorldAppDelegate.h
이파일들에담긴클래스는애플리케이션의시작점이되는메인코드라볼수

있다. app delegate는메인창과메인뷰컨트롤러를제어하고화면을구성하는

역할을한다.

HelloWorldViewController.m, HelloWorldViewController.h
이파일들의클래스는메인뷰를지니고있는데, 아주재미없는회색화면만을

보여준다. 곧‘Hello World’라고말하도록고칠것이다.

MainWindow.xib

이인터페이스빌더파일은프로젝트를컴파일하면애플리케이션번들에위치

하는 .nib 파일이다. 로드할 때 app delegate를 만들고, 메인 창과 뷰 컨트롤

러를로드한다.

HelloWorldViewController.xib

이파일은 HelloWorldViewController의뷰에쓰는디자인을정한다.
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NIB는 NeXTSTEP Interface Builder를 나타내고, XIB는 Xcode Interface Builder를 나타낸
다. NIB 파일은 컴파일된 난해한 바이너리 파일이고, XIB 파일은 사람이 읽을 수 있는 XML 파
일이다. 앞에서 말했듯이 Xcode는 XIB 파일을 NIB 파일로 컴파일한다. XIB 포맷은 소스 관리
차원에서 프로젝트에 NIB 파일을 합치는 문제를 풀기 위해 만들어졌다. 바이너리 파일보다
XML 파일을 훨씬 쉽게 구별할 수 있기 때문이다.

이제‘Hello World’텍스트를 그린다. 여러 가지 방법을 통해 이를 실행할 수

있다.

•HelloWorldViewController.m에 직접 코드를 적어서 Cocoa UILabel을 추가

한다.

•인터페이스빌더에서 HelloWorldViewController.xib에 Cocoa UILabel을추

가한다.

•UIView의 서브클래스를 정의하고, drawRect에서 Quartz 글꼴 렌더링을 이

용한다.

•OpenGL ES에서텍스처매핑texture-mapped 글꼴을만든다.

먼저 첫 번째 방법을 사용해보자. HelloWorldViewController.m에 코드를 적어서

UILabel을추가하는것이다. HelloWorldViewController.m 안에는이미코드를추

가하기 좋은 viewDidLoad라는 이름의 스텁 메소드가 있다. 이 메소드는 .nib 파일

의로딩이끝나고화면을그리기전에호출된다.

1..HelloWorldViewController.m의 viewDidLoad 함수를 다음의 내용으로 바꾼

다. 이함수는기본적으로주석처리되어있기때문에 /*부터 */까지의부분

을지워야한다.

- (void) viewDidLoad {
[super viewDidLoad];
// Cocoa UIKit을 사용해서 ”Hello World”를 그린다.
// 화면의 크기를 알아낸다.
int w = self.view.frame.size.width;
int h = self.view.frame.size.height;

// 레이블을 만들고 임의로 (100,50)이라는 크기로 설정한다.
// ”Hello World” 문자열을 충분히 담을 크기이다.
UILabel* label = [[UILabel alloc] initWithFrame:CGRectMake(0, 0, 100,     50)];
// 레이블을 화면 중앙에 놓는다.
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label.center = CGPointMake(w/2, h/2);
// 기본적으로 좌측정렬이기 때문에 문자열을 레이블의 가운데로 정렬시킨다.
label.textAlignment = UITextAlignmentCenter;
// 기본 배경색이 흰색이므로 레이블의 배경을 따로 그리지 않는다.

label.backgroundColor = [UIColor clearColor];
label.text = @”Hello world!”;
// 레이블을 그리기 위해 뷰에 레이블을 추가한다.

[self.view addSubview:label];
// 레이블에 메모리를 할당하였으므로 여기에서 레이블의 메모리를 해제한다.

[label release];
}

2..프로젝트를 빌드하고 실행한다. 이전에 실행한 시뮬레이터를 아직 종료하

지 않았다면 바로 종료한다. 이제 앱은 그림 1-3처럼 텍스트를 보여줄 것

이다.

그림 1-3 ‘Hello world!’텍스트가 보인다

이번에는두번째방법을사용해보자. 먼저인터페이스빌더를이용하여HelloWorld-

ViewController.xib에 UILabel을 추가해본다. 앞 예제를 따라 했다면 바꾼 부분들

을되돌려야한다.

1..Xcode의프로젝트파일목록에서 HelloWorldViewController.xib 파일을더

블클릭하여인터페이스빌더에서연다.

2..뷰오브젝트를더블클릭하여수정하기시작한다(그림 1-4 참조).
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그림 1-4 뷰 오브젝트를 더블클릭하여 파일을 수정한다

그림 1-5 Objects Library에서 Label 선택한다
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3..Library panel(열려있지않다면 Tools → Library Panel을선택하여 panel을연다)

에서 Label 오브젝트를찾는다. 그림 1-5를보라.

4..그림 1-6처럼 label을 View 수정창으로드래그한다.

5..‘Hello World’를보여주기위해새 label을더블클릭하고텍스트를수정한

다. Attributes Inspector(Tools → Attributes Inspector)에서도 수정할

수있다.

6..Label Size Inspector(Tools → Size Inspector)에서 Placement 버튼을

둘다클릭하여 label을그림 1-7처럼수평과수직으로가운데에위치하게

한다.

그림 1-6 View 수정 창에 새로운 label을 추가한다.

7.. .xib 파일을 저장하고 Xcode로 돌아온다. 애플리케이션을 빌드하면 그림

1-8처럼애플리케이션이실행될때보이는모습을만드는 .nib 파일을업데

이트한다.
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그림 1-7 Label 오브젝트 속성 수정

그림 1-8 Label 오브젝트로 만든‘Hello World!’텍스트
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8.. .nib 파일이로드되면 UILabel을만들어보여준다. 코드가만들어진 label을

읽거나수정하기위해접근하려면, 코드의 IBOutlet과연결한다. HelloWorld-

ViewController.h에서 HelloWorldViewController의 스텁stub 정의를 다음과

같이바꾼다.

@interface HelloWorldViewController : UIViewController {
IBOutlet UILabel* myLabel;

}

IBOutlet은 뷰의 오브젝트를 코드에서 처리할 수 있게 한다는 것을 인터페

이스빌더에알리는코드태그이다.

9.. .nib의 label을 아웃렛에 연결하기 위해 인터페이스 빌더의 HelloWorld-

ViewController.xib를 연 다음 Connections Inspector(Tools →

Connections Inspector)를 연다. 그 다음에 label을 클릭하여 선택하고,

label의 New Referencing Outlet을 File의 Owner 오브젝트에드래그한

후 놓고, 팝업 메뉴에 보이는‘myLabel’텍스트를 클릭한다(그림 1-9부터

1-11까지를 보자). Referencing Outlet을 설정했기 때문에 두 오브젝트는

.nib가 로드되면 서로 연결될 것이다. 다시 말해 HelloWorldView-

Controller.nib가애플리케이션에로드되면, myLabel 변수가 UILabel을가리

키도록연결된다는것이다.

그림 1-9 Label 연결 창
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그림 1-10 New Referencing Outlet을 클릭하고 File’s Owner로 드래그하기

그림 1-11 팝업 창에서‘myLabel’선택
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10..HelloWorldViewController.xib를저장하고인터페이스빌더를종료한다.

이제 코드는 myLabel을 통해 label에 접근할 수 있다. 이 연결 과정은 인터페이스

빌더에서 아웃렛, 액션, 딜리게이트, 데이터 소스를 명시하기 위해 자주 쓰인다.

인터페이스에보이는요소들과코드사이의모든소통은인터페이스빌더연결을

통해만들어진다.

1.1.3 뷰와 컨트롤러

아이폰 SDK에서 UIView 클래스는 View 오브젝트를 나타낸다. 뷰View는 드로잉
Drawing과 애니메이션, 이벤트 핸들링,서브 뷰 관리를 담당하는 화면의 사각영역이

다. 아이폰에서아이팟애플리케이션을보면상단의네비게이션바, 하단의탭바,

가운데콘텐츠영역의세부분으로분리되어있는뷰를볼수있다. 

새프로젝트마법사에서뷰기반애플리케이션view-based application을만들때에는하나의뷰

컨트롤러Controller와하나의뷰를가지고시작한다. 애플리케이션이더복잡해지면보다

많은뷰를필요로하게된다. 예를들어게임은지금하나의뷰를가지고있겠지만,

메인메뉴나설정화면, 온라인최고점수화면등을위한뷰가추가될수있다.

뷰들이한코드의많은부분을공유한다면, 그뷰들의코드를공유하는뷰컨트롤

러에추가하는것이합리적이다. 앞의예에서메인메뉴와설정은같은뷰컨트롤

러를쓰면좋았겠지만, 메인게임스테이트와최고점수화면을각각고유의뷰컨

트롤러에넣었다. 그둘을모두하나의뷰컨트롤러에넣거나각각다른뷰컨트롤

러에넣어도안되는것은아니지만순수하게구조적인면을고려한것이다.

1.1.3.1  새 뷰와 뷰 컨트롤러를 기존의 창에 추가하기

다음과정을거쳐새뷰와뷰컨트롤러를기존의창에추가한다.

1..Xcode에서 UIViewController를확장하는새클래스를만든다. 이를 TestView-

Controller라하자.

2.. File → New File을선택하고 User Interfaces 부분에서 View XIB를골라

서그림 1-12처럼새 XIB 파일을만든다.
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그림 1-12 새 View XIB 파일 추가하기

3..인터페이스 빌더에서 File의 Owner icon을 선택한다. Identity Inspector

에서 Class Identity를 TestViewController로 설정한다. Identity

Inspector 창이안열려있으면 Tools → Identity Inspector를통해열수

있다. 그림 1-13을보라.

4..앞의 Hello World 예제에서 했던 것과 같은 방법으로 그림 1-14처럼

View’s Referencing Outlet을 File’s Owner view로설정한다.

5.. TestViewController 인스턴스를 코드에 추가하고 IBOutlet을 적는다. 이를

app delegate class인 TestAppDelegate 안에넣을것이다. TestAppDelegate.h
에서새코드는이와같은모양이될것이다.

IBOutlet TestViewController* testViewController;
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그림 1-13 클래스 이름 수정

그림 1-14 File’s Owner 오브젝트에 연결하기
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6..메인창의 XIB 파일을수정하고 Library 창에서 MainWindow.xib 창으로

드래그하여 ViewController 오브젝트를추가한다. 그림 1-15와 1-16에서보

듯이 Library → Cocoa Touch Plugin → Controllers의 Library에서

ViewController오브젝트를찾을수있다.

그림 1-15 Library로부터 뷰 컨트롤러 추가하기
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그림 1-16 뷰 컨트롤러 오브젝트 수정하기

7..클래스의 이름을 바꾸고 NIB가‘TestViewController’를 로드하도록 바

꾸기 위해 이 오브젝트를 수정하자. 먼저 MainWindow.xib 창의 View-

Controller 오브젝트를선택하고 Identity Inspector 창에서클래스이름을

수정한다. 다음에는 같은 창의 Attributes 버튼을 선택하여 Identity

Inspector에서 Attributes Inspector로 바꾼다. 마지막으로, Attributes

Inspector에서 NIB 이름을수정한다. 그림 1-17과 1-18을참조한다.

8..이 오브젝트의 Referencing Outlet을 이전에 만든 TestAppDelegate의

IBOutlet인 testViewController에연결한다. 그림 1-19를보라.

9..다음코드를사용하여화면을보여주기전에 view 오브젝트를 Window 오브

젝트에추가한다.

[window addSubview:testViewController.view];

10.. View 오브젝트가 Window 오브젝트에추가되면호출하여활성화한다.

[window bringSubviewToFront: testViewController.view];
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그림 1-17 클래스 이름 수정

그림 1-18 NIB 이름 수정
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그림 1-19 TestViewController에 연결하기

어느 때건 오직 하나의 뷰만 활성화할 수 있다는 점을 기억하자. bringSubview-

ToFront를 호출하면 리스폰더 체인에서 현재 활성 중인 뷰는 제거된다. 그 뷰는

bringSubviewToFront를 다시 호출할 때까지 전면에 나타나거나 입력 이벤트를 받

지않을것이다.

1.1.3.2  새 뷰를 기존의 뷰 컨트롤러에 추가하기

이과정을따라서기존의뷰컨트롤러에새뷰를추가한다.

1..Xcode의뷰컨트롤러의 .h 파일을열고새뷰를위해 IBOutlet UIView 포인

터를 추가한다. 이름은 secondView라 짓는다. 코드는 이와 같은 모습이 될

것이다.

IBOutlet UIView* secondView;

2..인터페이스 빌더에서 뷰 컨트롤러의 XIB 파일 창을 열고 Library로부터

UIView 오브젝트를 추가한다. 그림 1-20처럼 UIView는 Library → Cocoa

Touch Plugin → Windows, Views & Bars 아래에서찾을수있다.

3.. UIView의 Referencing Outlet을 이전에 만든 IBOutlet인 secondView에 설정

한다.

4..뷰컨트롤러 XIB 파일창의 UIView 오브젝트에이름을붙일수있다.

5..뷰컨트롤러의어딘가에있는새뷰로바꾸기위해이를호출한다.

self.view = secondView;
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그림 1-20 Library로부터 뷰 오브젝트 추가하기

여기에서뷰컨트롤러의 view 속성을덮어쓰기때문에, 다시돌아올필요가있는

경우에는 이전 뷰를 참조할 레퍼런스를 가지도록 해야 한다. 일반적으로 각

UIView를고유의 IBOutlet에넣어야하며, 추가로 view 속성에초기시작 UIView를

할당해야한다. 어느 UIView이건하나이상의레퍼런스아웃렛을가질수있다. 따

라서초기뷰는 initialView라는이름의아웃렛과 view를가질것이다.

1.1.3.3  프록시 오브젝트

NIB 안의 오브젝트들은 File의 Owner 클래스 안의 속성들에 접근할 수 있다.

NIB 밖에서속성들에접근하려면 Proxy 오브젝트를사용해야한다. Proxy는연관

된클래스이름과프록시이름을지니지만연관된클래스의인스턴스를만들지는
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않는다. NIB 파일을초기화할때 Proxy 인스턴스에자신을넘겨주어야한다.

// 메인 윈도 NIB에서 뷰 컨트롤러를 자동으로
// 가져오지 않고, 수동으로 가져와서 프록시 오브젝트를 구성할 수 있다.
viewController = [[HelloWorldViewController alloc] init];
// viewController가 HelloWorldViewController와
// HelloWorldAppDelegate의 IBAction에 접근할 수 있어야 한다.
// File’s Owner는 View Controller가 되고,
// AppDelegateProxy는 app delegate [self]가 될 것이다.
NSDictionary*    proxies = [NSDictionary

dictionaryWithObject:self forKey:@”AppDelegate”];
// 프록시 오브젝트 이름을 app delegate 인스턴스에 연결한다.

NSDictionary*   options = [NSDictionary
dictionaryWithObject:proxies
forKey:UINibProxiedObjectsKey];
// 프록시로 옵션을 만든다.

[[NSBundle mainBundle] loadNibNamed:@”HelloWorldViewController”
owner:viewController options:options];

기기에 올리기

개발자 프로그램을 구입하고 가입절차가 끝나면, Xcode를 이용해서“Hello

World”예제같은애플리케이션을아이폰에올릴수있다. 하지만그전에해결할

어려운일들이아직남아있다.

아이폰은보안플랫폼이기에기기에서코드를실행하기전에해야할일들이잔뜩

있다. 빌드에 서명을 하고, 서명은 애플에 인증을 받아야 하고, 기기는 서명한 애

플리케이션을올릴준비가되어있어야한다.

서명과 인증 관리, 프로파일 작성은 애플 웹사이트의 프로그램 포탈을 통해 온라

인으로 이루어진다. 이미 프로그램을 구매한 개발자라면 http://developer.apple.
com/iphone/manage/overview/index.action에서할수있다.

포탈에서는서명인증요청Certificate Signing Requests, CSRs, 배포프로파일작성, 기기 ID 추

가등의각주제에맞는단계별가이드를제공하지만, 절차가복잡하기때문에먼

저전반적인개념에대해알아보도록하자.

1.2
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1.2.1 인증과 프로파일

애플리케이션을 전화기나 앱스토어에 출시하려면 서명한 프로파일이 2개 필요하

다. 하나는 애플리케이션을 개발하고 테스트하는 동안 사용하는 개발자 프로파일

이고, 다른 하나는 개발을 끝낸 애플리케이션을 퍼블리시publish하기 위해 앱스토어

에보낼때사용하는배포프로파일이다. 회사에서설정할때는수석프로그래머가

개발자프로파일을사용하고, 제품매니저는배포프로파일을사용할것이다.

프로파일들을만들려면공개키Public Key와개인키Private Key를가진인증서를만들어야

한다. 이인증서는애플의서명을받아야사용할수있기때문에제일먼저할일

은 맥에서 키체인 접근Keychain Access을 사용하여 애플의 개발자 프로그램에 보낼 인

증서의뢰요청Certificate Submission Request을만드는것이다. 애플에서요청을확인하고수

락하면애플개발자포탈웹사이트에서인증서를다운받을수있다.

애플이서명한인증서를받은다음에는 App ID, UDID와 WWDR 인증서가필

요하다.

1.2.1.1  App ID

프로파일과 애플리케이션 번들에 사용하는 App ID는 개발자 포털에서 만든다.

App ID는‘com.게임회사이름.게임이름’의 형태를 취한다. 이것을 리버스 도메인

표기라고 부르는데, 자바와 C# 프로그래머들은 패키지 이름 포맷과 같기에 익숙

할것이다.

한개발자가여러개의애플리케이션을만들때와일드카드포맷을사용해서애플

리케이션들에 하나의 App ID를 사용할 수도 있다. 와일드카드를 사용한 App

ID는‘com.게임회사.*’의형태를취한다. 

App ID를 개발자 포탈에 기록하면 ID의 앞에 영문과 숫자로 이루어진 10개의

문자가추가된다. 이는애플에서내부적으로사용하는것이니무시해도상관없다.

개발자 포탈에서 App ID를 만든 후에, 애플리케이션 번들에서 Info.plist 파일을

열고 bundle identifier key의기본값을 App ID 값으로바꾼다. 포탈에서 App

ID를 만들 때 와일드 카드를 사용했다면 Info.plist 파일을 수정할 때 *를 게임 이

름으로바꿔야한다.
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1.2.1.2  UDID

UDID는 프로그램을 올릴 아이폰 기기에서 얻는 40글자의 16진수 문자열인데,

기기를맥에연결하고아이튠즈나 Xcode Organizer 창을열면알수있다.

UDID는 개발자 프로파일에만 쓰이고 배포 프로파일에는 쓰이지 않는다.

1.2.1.3  WWDR 인증서

애플의 Worlde Wide Developer RelationsWWDR 인증서는 애플 사이트의 http://

developer.apple.com/certificationauthority/AppleWWDRCA.cer에서 구할 수 있

다. 인증서를 다운로드하여 설치하면 빌드를 인증할때사용할 수있다. WWDR

인증서는개발인증서를애플과연결하여애플리케이션의신뢰체인을완성한다.

1.2.1.4  프로파일 설치

이 셋을 갖추고 나면 개발자 포탈에서 준비Provisioning 프로파일을 다운로드할 수 있

다. 이 파일은 .mobileprovision 확장자를 가진다. 다운로드한 다음에 더블클릭을

하면 프로파일을 설치한다. 이 프로파일은 Xcode의 Organizer에 넣어야 하고,

아이폰을컴퓨터에연결하면 Xcode의 Organizer에나타나게된다. 이때프로파

일이기기에설치된프로파일목록에있는지꼭확인해야한다.

애플리케이션은개발자프로파일의목록에있는기기에서만실행할수있다는것

을기억하자.

1.2.2 Xcode 설정

모든 인증서, 키, 프로파일 설치가 완료되면 아이폰에서 실행할 애플리케이션을

컴파일하는 Xcode를설정할준비가된것이다.

Project → Edit Project Settings → Build → Code Signing Identity → Any

iPhone OS Device에서코드서명프로파일을설정한다. 그림 1-21을보라.
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provisioning 프로파일이 드롭-다운 목록에 나타나지 않으면 서명 체인의 어느

부분을빠뜨린것이다.

•개인키

•서명인증서

•WWDR 인증서

•provisioning 프로파일

그림 1-21 코드 서명 프로파일 설정

bundle identifier를 provisioning profile의 App ID name에 맞도록 바꾼다.

Info.plist가바뀐후에 Build Clean 메뉴옵션을선택한다. 하지만변화는빌드에

반영되지않을것이다. 그림 1-22를보자.
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그림 1-22 Info.plist의 App ID를 수정

기기를위해빌드하도록그림 1-23처럼 Xcode를설정한다.

그림 1-23 빌드 대상에 맞는 기기를 설정
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모든과정이잘이루어졌다면애플리케이션을빌드하고기기에서실행할수있을

것이다. 빌드가진행되는동안 Xcode는앱을기기에설치할것이다.

무언가 잘못되었다면 유용한 에러 메시지는 볼 수 없고 잘못되고 있다는 의미를

담고있는‘ApplicationVerificationFailed’를보게될것이다. 다음은에러의원

인이될수있는흔한유형의목록이다.

bundle identifier가 오자나 공백을 포함한다

bundle identifier는 App ID에 맞추어야 한다. 번들 identifier를 수정한 후

에 Build → Clean을선택한다.

인증 체인의 일부를 찾을 수 없다

WWDR 인증서는잊기가쉽다.

인증서가 만료됐다

모든것이잘됐는데갑자기문제에직면한다면인증서가만료됐을것이다. 

때로는아이폰을리부팅하고다시연결하는것만으로도문제가해결되곤한다.

Objective-C 입문

아이폰 API는 Objective-C 언어를 사용한다. Objective-C는 스몰토크와 C언

어의원리를응용한것이다. 발상은업계의표준인 C 언어의힘과스몰토크언어

의 OOP 접근을 합치는 것이었다. 이로 인해 처음엔 혼란스럽겠지만 몇 가지 개

념을이해하면그구조를이해하기어렵지않을것이다.

먼저알아야할것은 Objective-C가 C를포함한다는점이다. C로작성한것은모

두 Objective-C 컴파일러를 이용해 컴파일할 수 있다. C 스타일 구조,함수 호

출, 메모리할당,포인터 모두 가능하다. 여기에보통 C 언어 문법의 기본 이외에

Objective-C는 스레드 동기화, 트라이-캐치 블록, 가비지 컬렉션 같은 고유의

기능 몇 가지가 추가되었다. 그리고 주 개선점이자 핵심은 객체지향 기반이라는

것이다.

1.3
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1.3.1 클래스

Objective-C의클래스는자바나 C++의클래스와개념적으로매우비슷하다. 클

래스class는 멤버 변수member variable라 부르는 데이터와 메소드method라 부르는 함수를 포

함하는오브젝트이다. 자바와 C++에서와같이클래스는사용하기전에정의된다

(Objective-C에서는런타임에클래스가만들어질수있다). 클래스는 @interface 키워

드를사용하여정의한다. C++와비슷하게 Objective-C 클래스는.h 파일에정의

를 하지만, 구현은 .m 파일에 분리하여 해야 한다. 또한 C++로 하는 것처럼

@public이나 @private 키워드를사용하여따라오는줄의보호문법단계를표시한

다. 그러나Objective-C는 C++나자바와다르기때문에메소드를클래스의중괄

호바깥에정의한다. 메소드는바로앞의클래스와연관이되고 @end 키워드로끝

난다.

다음코드는 Animal 클래스를만든다.

@interface Animal
{

// 멤버 변수는 여기에 둔다.

@private
int foo;

}
// 클래스 메소드는 중괄호 바깥인 여기에 둔다.

- (int) bar: (double) input1;
@end

메소드를 정의하는 재미있는 방법을 기억하자. 보통 함수는 -로 시작을 하고(+는

클래스 메소드에 사용을 한다. 곧 다룰 것이다), 괄호 안에 리턴 타입을 적고 이어서

함수의 이름을 적는다. 함수가 파라미터를 가지면 콜론 뒤에 각 파라미터 설명을

적는다. 파라미터 타입은 괄호안에 적는다. 그리고파라미터 이름을 적는다(파라

미터이름대신함수이름을사용하는첫번째파라미터는제외한다).

여기에 C++로 작성한 같은 클래스가 있다. 마지막에는 세미콜론이 필요하다는

것에주의하자.
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class Animal
{

// 멤버 변수는 여기에 둔다.
private:

int foo;
public:

int bar( double input1 );
};

자바로한번더해보자.

class Animal
{

// 멤버 변수와 메소드는 여기에 둔다.
private int foo;
public int bar( double input1 ) {}
}

세언어모두 //로한줄주석을사용한다.

그리고 자바와 C++처럼 클래스는 다른 클래스를 확장extend 또는 상속 inherit할 수 있

다. 거의 모든 Objective-C 클래스가 상속하는 공통 베이스 클래스는 후에 설명

할 NSObject이다. 상속 문법은 public과 private이 부모 클래스의 앞에 사용되지

않는것을제외하면 C++와비슷하다.

@interface Animal : NSObject
{

}
// Objective-C 상속

@end

class Animal : public NSObject
{

// C++ 상속
}
;

class Animal extends NSObject
{

// Java 상속
}
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자바처럼 Objective-C도여러클래스를상속할수없다는점을주의하는것이중

요하다. NSObject뿐만 아니라 게임의 특수한 이벤트들에 응답할 수 있는

GameEventListener 클래스도 같이 상속하는 Animal 클래스를 만들고 싶다고 해보

자. C++에서는 GameEventListener를 추상 베이스 클래스로 정의하고 둘 다 상속

할수있다. 그러나자바에서는 GameEventListener를인터페이스클래스로정의해

야하고, Objective-C에서는 @protocol로정의할것이다. Objective-C의프로토

콜은절대적으로 virtual이어야한다는점만제외하고 C++에서의추상베이스클

래스와비슷하다. 어떠한멤버변수나메소드구현을가져서는안된다. 자바의인

터페이스처럼 Objective-C의 클래스는 필요한 만큼 많은 프로토콜을 구현할 것

이다.

C++ 구현은이렇게한다.

class GameEventListener
{

// 멤버 변수, 메소드, 가상 메소드는 여기에 온다.
private:

bool active;
public:    

bool isListening(); // active가 true일 때 true를 리턴한다.
virtual void handleEvent( int event ) = 0;

}; 
class Animal : public NSObject, public GameEventListener
{

// 멤버 변수, 메소드, 오버라이드 메소드가 여기에 온다.
// GameEventListener의 모든 순수 virtual 함수는 반드시 구현해야 한다.

private:
int foo;

public:
int bar( double input1 );
void handleEvent( int event );
// isListening()은 구현되어 있으므로 오버라이드할 필요가 없다.

};

여기에자바로같은구현을했다.

interface GameEventListener
{

// 인터페이스는 멤버 변수를 포함하지 않는다.
// 메소드 정의는 여기에, 하지만 아직 구현은 하지 않는다.
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public bool isListening( );
public void handleEvent( int event );

}

class Animal extends NSObject implements GameEventListener
{

// 멤버 변수, 메소드, 오버라이드 메소드는 여기에 온다.
private int foo;
private bool active; // 여기서 꼭 정의해야 한다.

public int bar( double input1 ) {}
public bool isListening( ) {}
public void handleEvent( int event ) {}

}

자바 인터페이스 클래스는 Objective-C에서 프로토콜 클래스라 부른다. 그리고

@protocol을사용하여정의한다.

@protocol GameEventListener
// 프로토콜은 멤버 변수를 포함하지 않고 중괄호도 사용하지 않는다.
// 메소드 정의는 여기에, 하지만 아직 구현은 하지 않는다.
- (BOOL) isListening;    
- (void) handleEvent: (int) event;    

@end

@interface Animal : NSObject <GameEventListener>
{

// 멤버 변수는 여기에 둔다.
@private

int foo;
BOOL active;

}

// 메소드와 오버라이드 메소드는 여기에 둔다.
- (int) bar: (double) input1;
- (BOOL) isListening;
- (void) handleEvent: (int) event;    

@end

C++의 템플릿 클래스나 자바의 제네릭을 경험해 본 프로그래머라면 여기서 혼란스러울 수 있
다. Objective-C의 프로토콜 사용 문법이 C++의 템플릿이나 자바의 제네릭 문법과 비슷하기
는 하지만 같은 것은 아니다.
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앞에서언급했듯이함수구현은.m 파일에분리된다. C++ 구현예제는이런모양

이될것이다.

bool GameEventListener::isListening()
{

return active;
}

void Animal::bar( double input1 )
{

// input1으로 할 일을 한다.
}

void Animal::handleEvent( int event )
{

// event에 따라 할 일을 한다.    
}

그리고 Objective-C 구현은이런모양이될것이다.

@implementation Animal

@synthesize foo;

- (void) bar: (double) input1
{

// input1으로 할 일을 한다.
}

- (BOOL) isListening
{

return self.active;
}

- (void) handleEvent: (int) event
{

// event에 따라 할 일을 한다.
}

@end
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1.3.2 인스턴스화

클래스를정의했다면인스턴스를만들고싶을것이다.

C++와자바에서인스턴스는다음과같은모양이될것이다.

Animal* beaver = new Animal();

반면에 Objective-C에서는이렇게한다.

Animal* beaver = [Animal alloc];

1.3.3 메시지

alloc 호출주변에대괄호를사용한것은 Objective-C의재미있는기능인메시지
massage라는것이다. 그것은 Objective-C 오브젝트의함수를호출하는기본적인방

법이다. 문법이새롭겠지만개념은 C++나자바의함수호출과같다. 앞의예제에

서 Animal 클래스의 new 함수를 호출한다. new 함수는 클래스의 인스턴스를 새로

할당하여리턴한다.

예상대로그오브젝트의함수를지금이렇게호출할수있다.

BOOL listening = [beaver isListening];

C++에서는이런모양을지닐것이다.

bool listening = beaver -> isListening();

자바에서는이런모양을지닐것이다.

boolean listening = beaver.isListening();

파라미터전달도가능하다. 파라미터는콜론으로구분한다.

[beaver handleEvent: EVT_EXAMPLE ];

C++에서는이런모양이된다.
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beaver -> handleEvent( EVT_EXAMPLE );

자바에서다시하면다음과같이된다.

beaver.handleEvent( EVT_EXAMPLE );

메시지에하나추가되는것은키워드이다. 첫번째이후의각파라미터앞에는키

워드가 붙는다. Animal 클래스가 찾을 음식의 양과 채소만 허용할지를 지정하는

findFood라는함수를가졌다면이를볼수있다.

[beaver findFood: 50 vegetablesOnly: true];

C++의같은함수는이런모양이다.

beaver -> findFood(50, true);

이것은함수호출이더많은화면을차지하도록하지만, 읽기는더편해진다. 함수

정의를 찾아보거나 넘겨줄 값의 성격을 이해하기 위해 IDE의 코드 완성 기능에

의존할필요가없기때문이다.

또한 파라미터가 있어야 할 곳에 다른 대괄호 세트를 넣어서 메시지를 중첩할 수

있다. Animal 클래스가 BOOL -isVegetarian 함수를가졌다면이를볼수있다.

[beaver findFood: 50 vegetablesOnly: [beaver isVegetarian]];

C++에서는이런모양이다.

beaver -> findFood(50, beaver -> isVegetarian());

C++나 자바의 const 또는 factory 메소드와 같은 것을 Objective-C에서 하려면 @interface

부분에서 메소드 이름 앞에 +를 사용한다. 이것은 클래스의 인스턴스 없이 클래스의 함수를 호
출 가능하게 만든다.

예를 들어, 다음과 같다.

@interface Animal
+ (BOOL) canAnimalsTalk;

@end

다음의 방법으로 호출할 수도 있다.
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[Animal canAnimalsTalk];

이를 Objective-C에서는 클래스 메소드라 부른다. 클래스의 인스턴스 대신에 클래스 자신이
직접 호출하기 때문이다. 이 방법으로 선언한 함수는 클래스의 멤버 변수를 사용할 수 없다.

1.3.4 멤버 변수

Objective-C는 클래스 멤버 변수에 접근하는 여러 방법을 제공한다. 첫 번째 방

법은 메시지를 이용하는 것이다. 함수의 이름이 접근하려는 멤버 변수와 같을 때

사용한다. 이것을 accessor 함수라 부르고, C++나 자바의 get과 set 함수 작성과

비슷하다. 클래스의 @implementation 부분에서 @synthesize 키워드를 사용하고 .h
파일에서정의할때 @property를사용하면함수는자동으로만들어진다.

사용문법은다음과같다.

int example = [beaver foo]; // int foo의 값을 리턴한다.

[beaver setFoo:10]; // int foo에 10을 넣는다.

자동으로 만들어진 setter 메소드의 이름은 set 뒤에 변수의 이름이 첫 글자가 대

문자로되어이어짐을기억하자. 같은목적으로다음처럼 dot 표기를사용할수도

있다.

int example = beaver.foo; // int foo의 값을 리턴한다.

beaver.foo = 10; // int foo에 10을 넣는다.

C++와 자바에서의 this 키워드처럼 Objective-C 클래스 메소드에서는 self 키워드를 사
용한다.

1.3.5 메모리 관리

Objective-C는 C를 포함하기 때문에 malloc과 free에 관한 모든 규칙이 동일하

게 적용된다. 아이폰에는 자바처럼 모든 오브젝트를 관리하는 가비지 컬렉터가
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없다. 따라서할당한메모리를적절히해제하지않으면메모리누수가일어날수

있다.

그러나 Objective-C는 베이스 클래스 NSObject 안에 레퍼런스 카운터를 구현한

다. 그러므로 NSObject를 상속한 모든 클래스는 같은 레퍼런스 카운트 기능을 내

부에 지닌다. 다시 말해 NSObject가 제공하는 copy, new, retain, release,

autorelease, alloc 메소드를사용할수있다는것이다.

NSObject 서브클래스인스턴스가 alloc 메소드나 new 또는 copy를이름앞에붙인

함수를사용하여만들어지면, 레퍼런스카운트가 1인상태로만들어질것이다. 이

값을 1 증가시키려면 retain 함수를 사용할 수 있고, 1 감소시키려면 release와

autorelease 함수를 사용할 수 있다. 레퍼런스 값이 0이 되면 오브젝트는 메모리

에서제거될것이다.

오브젝트에 retain을 호출하고 release나 autorelease를 그 오브젝트에 호출하지

않을경우, 레퍼런스카운트가 0이되지않아서메모리누수가생길것이다.

1.3.6 생성자와 소멸자

C++처럼 Objective-C 클래스는생성자와소멸자함수개념을지원한다. 그러나

약간 차이가 있다. 오브젝트가 할당될 때 프로그래머는 초기화 함수를 수동으로

호출해야한다. 기본적으로초기화함수는 init이라는이름을지닌다.

다음코드는전형적인 Objective-C이다.

Animal* beaver = [[Animal alloc] init];

Objective-C 클래스가 메모리에서 제거될 때, 소멸자와 비슷한 dealloc 함수가

호출된다. 클래스에서 dealloc 함수를 오버라이드하면 수퍼셋 클래스의 dealloc

메소드를꼭호출해야한다. 그렇지않으면메모리누수가일어날것이다.

-(void) dealloc {
// 소멸자 코드를 여기에서 수행한다.
[super dealloc];

}
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1.3.7 인터페이스 빌더 통합

Objective-C와 인터페이스 빌더는 아이폰 앱 제작에 함께 사용되기 때문에,

Objective-C 코드를 인터페이스 빌더 뷰에 연결하기 위해 IBOutlet과 IBAction

매크로를포함시킨다.

UI 변수 앞에 IBOutlet을 놓고 클래스 메소드 앞에 IBAction을 놓으면, 인터페이

스빌더는코드가사용하는변수와함수들을알게된다.

@interface myWindow
{
IBOutlet UIImageView *backgroundImage;
IBOutlet UIWindow *window;
IBOutlet UISwitch*soundToggle;
}
- (IBAction) playgame;
- (IBAction) toggleSound:(id) sender;
- (IBAction) handleEvent:(id) sender forEvent:(UIEvent*) event;
@end

컴파일 타임에 IBAction은 void로 바뀌고, IBOutlet은 간단히 제거된다. 이것들은

인터페이스빌더에서메소드와변수들을보이게하기위해사용될뿐런타임효과

는없다.

1.3.8 C++와 Objective-C 혼합

Objective-C는 C 언어의수퍼셋이기때문에코드대부분을 C 언어로작성할수

있다. 그리고 Objective-C 컴파일러는 프로젝트에 C++ 또한 사용 가능하다. 같

은 파일에서 C, C++, Objective-C 문법을 사용하는 것도 가능하다. C++ 구현

을포함한파일은확장자로.m 대신에.mm을사용해야한다.
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결론

이장에서는 Objective-C 언어의기초이해와코드를작성하고컴파일하여아이

폰에서실행하는절차를보여주었다. 언어와 API의지식을완전히소화하기에필

요한 만큼 많은 튜토리얼을 읽어보길 권한다. 특히 http://developer.apple.com의

문서는매우유용한데, 애플개발자계정으로접근하면무료이다.

그러나게임은매우복잡한애플리케이션이기때문에게임프로그래밍이면의이

론적이해없이는게임개발이매우큰도전이될것이다. 게임프로그래밍을처음

시작한다면, 게임을만들기전에다음장을완전히읽어보는것이큰도움이될것

이다.
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